
 
 

 

Page 1 

BLD221644 

Sustainability Case Studies: Perkins + Will and 
Johnson Controls 
Jarod Schultz 
Director of Research and Development 
MasterGraphics.aec 
 

 

Description 

See how Autodesk sustainability design tools were used for the Architecture 2030 initiative with 
Perkins + Will, Johnson Controls, and MasterGraphics.aec.  
 
The Perkins + Will case study centers around Director of Research John Haymaker’s "Design 
Space Construction / Sprout Space" project. Discover how Perkins + Will and 
MasterGraphics.aec used Dynamo Studio, Fractal, FormIt, Revit software, and Insight to meet 
design, energy (2030), and view quality requirements.  
 
Learn how Johnson Control’s Clay Nesler (VP of global energy and sustainability) and 
MasterGraphics.aec used FormIt, Revit, and Insight on the JCI Shanghai HQ project, where 
they compared the accuracy of their existing process using other competing tools to the Insight 
workflow. In Mr. Nesler’s words, “this is uncanny”—to see not only how close the results were, 
but also how few hours were used to generate the schematic design, design development, and 
construction documents models for the comparison, and that a large ROI was discovered. 
 

Speaker 

I help AEC firms streamline bottlenecks and pain points in their daily people, process, and 
technology workflows. With a business strategy session with key people I assess the current 
situation based on targeted Q/A and build a goal-oriented plan. My expertise is; Sustainability 
Solutions | Computation/Generative Design Processes | Delivering Creative Solutions | 
Architecture, Engineering and Construction Software | Strategic Growth, Process and Workflow 
Management | Software Development/Documentation | and Kaizen Event/Emotional Intelligence 
Practitioner. 

Learning Objectives 

• Learn how 2 companies are utilizing the Autodesk sustainability tools 

• See how Dynamo, FormIt, Revit, and Insight can be best capitalized on for the 
Architecture 2030 initiative 

• Understand how the Insight sustainability workflow can be used by everyone in the 
firm, not just a select few, when compared to the competing products 

• Learn how “accuracy” is the new method to determine energy use intensity (EUI) to 
better design and build sustainable buildings 
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2030 Challenge Goals 

 
One of these industry demands are the Architecture 2030 Challenge goals. Architecture 2030 
states that all new buildings, developments, and major renovations be carbon-neutral by 2030, 
with incremental benchmarks leading up to the goal date. 
 
73% of the 20 largest A/E firms, responsible for over $100 billion in construction annually, have 
adopted and are implementing the 2030 Challenge. Approximately 40% of all US architecture 
firms have adopted the Challenge. 
 
One of the first adopters of the 2030 Challenge was the AIA. They’ve been tracking progress 
through the AIA 2030 Commitment and require firms to report their progress through the Design 
Data Exchange (DDx). 
 

Building = Biggest Polluters + Energy Consumption 

Buildings consume nearly half of all the energy produced in the United States. Buildings are 
responsible for nearly half of US CO2 emissions 
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Energy Simulation 

 
Energy modeling is critical to achieving these 2030 targets as well as other energy efficiency 
standards. Almost 80% of projects that did not have an energy model and failed to meet the 
40% reduction goal (from before 2005). 
 
How can we expect to meet these targets and goals if we don’t know how our design decisions 
are impacting performance?  
 

AIA 2030 

Autodesk is committed to helping customers achieve 2030 energy reduction targets, and to help 
with this, they have automated AIA 2030 Commitment reporting to the Design Data Exchange 
(DDx). Instead of manually entering your 2030 data for each project, you can simply send 
project data from Insight directly to the DDx. Over 500 firms committed; LINK 2030 Design Data 
Exchange; LINK 
 

 

https://www.aia.org/2030-directory?query=
https://2030ddx.aia.org/users/sign_in
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Autodesk Insight 

 
Any Revit model works with Insight but let’s not forget about FormIt for early conceptual design. 
Building Energy Analysis is built in starting with 2017.1 and going forward. Install Plugin for 
Solar Radiation, Daylighting, and Heating/Cooling Load Analysis. LINK 
 
Building Energy Analysis – Computational - DOE2.2 + EnergyPlus engines and typically does 
248 runs in the cloud on Green Building Studio; GBS, tested and documented against ASHRAE 
140 Practical + Several customers 
 
Daylighting - Uses Autodesk A360 Rendering, a cloud-based engine that uses bidirectional ray 
tracing. This engine has been validated against Radiance and real-world measurements.  
 
Solar Radiation – Perez sky model, tested by NREL; National Renewable Energy Laboratory 
Golden Colorado 
 
Heating/Cooling – EnergyPlus – ASHRAE 140 
 

How is Insight Different 

With over 177 different programs to choose from, and growing every month; International 
Building Performance Simulation Association USA – LINK why choose Insight? If I was to pick 
one word… BIM, not merely just in terms of Revit – we all know BIM is more than just Revit, it’s 
about the process. 
 
 
 

https://insight360.autodesk.com/oneenergy/Landing/Download
https://www.buildingenergysoftwaretools.com/
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Here is a great example of how Insight is different compared to the other software products 
 
On the right side using other software products you must use; specialists, separate model, only 
special projects, and additional cost. 
 

 
 
One the left you have Insight; does 248 runs for accuracy, Schematic Design to Construction 
Document, anyone can use it, single model usage, use it on every project, included in your AEC 
Collection. 
 

Johnson Control Workflow 
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Validate Existing Analysis 
Used other software products and wanted to see how Insight could be used to validate the 
workflow and see how the Energy Use Intensity or EUI outcome would be on Johnson Controls 
new Shanghai HQs. 
 

 
 

Building Overview 
Numerous technologies used for energy savings. Expected to generate 44 percent savings in 
overall energy consumption compared to the local market standard. Additionally, the building is 
expected to reduce water usage by 42 percent via its grey water recycling and storm water 
recapture facilities 
 

 
 
44,300-Square Meter building or for us Americans; 476,841.23 Square Feet, sizeable building 
compared to the average 19,000 SQ FT commercial building in U.S. 
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Sets a new standard for green and smart buildings, being the first in China to receive several 
top global energy efficiency awards including: IFC-World Bank Group’s EDGE (Excellence in 
Design for Greater Efficiencies) Certification, U.S. Green Building Council’s LEED (Leadership 
in Energy and Environmental Design) Platinum Certification, and the China Green Building 
Design Label Three Star Certification. 
 

 
 

Validating Workflow 
Not sure if anyone recognizes this building or has seen my presentation that I did in the spring 
of 2017. This was my comparison model when I was looking at Sefaira vs Insight and validating 
the workflow from FormIt to Revit based on the idea of Schematic Design, to Design 
Development, to Construction Document using Insight. LINK 
 

 

https://knowledge.autodesk.com/support/revit-products/getting-started/caas/simplecontent/content/formit-revit-insight-bye-bye-sketchup-sefaira.html
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I took that same process and workflow and applied it to the Johnson Controls Shanghai project. 
This was a little different since I had to go backwards in the workflow; going from the CD model 
and developing a FormIt model for a SD model. Then taking that into Revit to develop the DD 
model. 
 

 
 

Energy Analysis Engines 
Remember Insight uses the DOE2.2 + EnergyPlus engines and typically does 248 runs in the 
cloud on Green Building Studio; GBS. This has been tested and documented against ASHRAE 
140 Practical + Several customers. 
 

 
 
 

https://gbs.autodesk.com/GBS/
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Heating and Cooling Loads 
Additional data that is part of the EnergyPlus analysis is the heating and cooling load 
information. You can see a report inside Revit by going to the Analyze tab and selecting the 
Heating/Cooling button. For a visualization you can select the Optimize button to open Insight 
and at the top right select the Visualize drop-down 
 

 

Findings 
The below image shows what the energy number were based on by the default 
FormIt/Revit/Insight settings. Out the gate the Energy Use Intensity (EUI) numbers were: 194 
kWh/m2/yr which is just below ASHRAE 90.1 at 228 
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The below image shows what the numbers were based on my investigation about the actual 
building elements: EUI 99.3 which is below ASHRAE 90.1 at 228 and closer to the Architecture 
2030 EUI 59.0. 
 

 
 
With some minor adjustments from Clay, being Lighting Efficiency, Wall Construction, HVAC, 
and PV Surface Coverage, it went down to: EUI 84.3. 
 

 
 
Using Clay’s words once he saw the results; “uncanny on how close you got to our numbers” 
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The energy performance range is continuous and not a roller coaster ride as you go through the 
design changes and update the energy model, all within 10%. This is from my findings back in 
the spring of 2017; LINK 
 

 
Below are the findings form the Johnson Control project. 
 

 
 

Schematic Design: FormIt + Insight 
For the below workflow you can watch my Autodesk University class called “Design Strategies 
with FormIt”; LINK 
 
Key Learning 
 

• Discover strategies on working between FormIt 360 and Revit models 
• Learn best practices for helping convert SketchUp users to FormIt 360 
• Learn how to take advantage of Insight 360 for facade and energy analysis 
• Learn how to take the FormIt 360 model into Revit for further study 

 

http://au.autodesk.com/au-online/classes-on-demand/class-catalog/classes/year-2016/formit-360/ar18857#chapter=0
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Using FormIt you can define the location of the project and import a satellite photo to start 
sketching a simple mass model based on the building foot print. You can include levels to divide 
the mass model vertically to help with your energy analysis. If it is an urban location, you can 
define simple masses of the buildings that surround the project to get a more accurate energy 
analysis. 
 
With the FormIt model defined we can select the energy analysis tool in FormIt and generate an Insight 
energy model. Insight will give us a base energy cost range / EUI which we can save as a default 
scenario in Insight.  With the benchmark set, we can start modifying the different factors; building 
orientation, wall to window ratios, window shades, building materials, etc. to better define the building 
elements.  
 
As we change these factors we will get instant feedback on the benchmark of what factors will gives us 
the best sustainability for the building. With these new factors we can add additional scenarios to show 
the progression of what we changed so we can compare them at any given time. 
Even at this early stage we can look at EnergyPlus heating and cooling loads from the model. Showing us 
load density, peak load, and floor area data. We can also export multiple energy model formats being; 
Energy Plus, GbXML, and DOE-2, if additional analysis is needed. 
 

Design Development – FormIt + Revit + Insight 
As the project progresses from schematic design to design development we can bring the 
FormIt model into Revit. The FormIt model will be converted to Revit masses and the levels will 
also be converted so we can continue to use them for documentation in Revit. 
In Revit we have tools for walls, curtain walls, floors, and roofs to help us to convert from the 
mass to Revit building elements. We will use these building elements to help us move further 
into design development for our initial cartoon set. 
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Once the building elements have been placed we can generate another Insight 360 analysis 
and compare the base energy cost range / EUI from the previous FormIt model. Like before, we 
can look at the EnergyPlus data along with exporting the Energy Plus, GbXML, and DOE-2 files. 
We can also reuse the existing scenarios that we created earlier with this new Insight energy 
model for comparison. 
   

Construction Document – Revit + Insight 
We can continue developing the Revit model for construction document purposes. Adding 
additional detail to the model for construction clarification being; details, sections, elevations, 
enlarged plans, schedules, and annotation. 
 
Even in this phase will can generate additional Insight energy models to help track the 
substantiality of the building. Reusing all of the previous mentioned scenarios and exporting of 
Energy Plus, GbXML, and DOE-2 files for further analysis. 
 

Perkins + Will Workflow 

Computational Design 
The workflow that is shown is based on a Perkins + Will relocatable classroom building (Sprout 
Space). This was first presented at the ACADIA conference by John Haymaker called “Design 
Space Construction”, see Figure 1.  

 
Figure 1: A Sprout Space Design, as constructed. 
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You must have the following software loaded or have logins to these cloud based tools; Dynamo 
Studio, Project Fractal, Revit, Insight, and Insight Revit Plugin. 
 

 

Objective 
The objective is to use computational design to help us with performance-based design to 
minimize energy consumption along with maximizing daylight and view quality. We will also 
analyze incident solar radiation, building orientation, wall to window ratio, photovoltaics (PV), 
and building element construction to help achieve our goals. 

Goals 
Goals can define specific Experiential, Ecological, or Economic targets. However, in most cases 
it is impossible to maximize all goals simultaneously and the optimization of a single goal must 
be compromised in order to maximize overall value. For example, maximizing View Quality 
(TO), but minimizing Energy Consumption (FP) for heating in the winter or cooling in the 
summer are both affected by the window/wall ratio of the building envelope.  

https://www.autodesk.com/products/dynamo-studio/overview
https://www.autodesk.com/products/dynamo-studio/overview
https://home.fractal.live/
https://www.autodesk.com/products/revit-family/overview
https://insight360.autodesk.com/oneenergy
https://insight360.autodesk.com/oneenergy/landing/download
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Examples of goals: 

• Minimize Energy Consumption 

• Maximize Daylight 

• Maximize View Quality 

Constraints 
Constraints are requirements. Alternatives that violate a constraint are not viable. For example, 
in the Sprout Space case study perhaps the floor area should be a constraint to ensure enough 
room is provided for the desired program, but not so large that it takes up too much of the site. 
Example of a Constraint: 

• At least 75% of all occupied floor area must have a direct line of sight to the outside, 
according to LEED 4.0. 

• Providing a larger % of view area might then be formulated as a goal that can be traded 
off against other Goals. 

Metrics 
In order to combine multiple Goals and Constraints into a single value function they must be 
quantifiable. The Metric is the unit in which a Goal or Constraint is quantified. While objectives 
are declared in qualitative terms, their related indicators are in quantitative ones. The Following 
metrics are examples that begin to allow the verification of fulfillment of the constraints, and the 
assessment of the degree of satisfactions of the goals (Table 1.1). 

Table 1.1: Quantification of the qualitative objectives 

Objectives Indicators Metrics 

Minimize Energy Consumption Energy Use W/m2 

Maximize Daylight Daylight Factor % 

Maximize Quality View Quality View (QV) % 

Maximize Quality View Direct Line of Sight (DLS) % 

Preferences 
Goals and Constraints, defined with proper metrics, can begin to be sorted in order of 
importance, from those that are mandatory to those that are merely desirable. Stakeholders 
define their unique preferences by prioritizing objectives. Gathering preferences can help drive 
the formulation, generation and analysis when compromises must occur. Ultimately, a set of 
design alternatives will be ranked differently depending on the set of Stakeholder Preferences 
used to evaluate them.  

 

 

https://bernalm.gitbooks.io/design-space-construction/content/GLOSSARY.html#goal
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Examples of preferences: 

• Student: Minimize Energy Consumption 20%, Maximize Daylight 30%, Maximize 
View Quality 50% 

• Teacher: Minimize Energy Consumption 40%, Maximize Daylight 40%, Maximize 
View Quality 20% 

Alternatives 
There are many ways to generate a space of Alternatives, including manual, parametric, or 
computational strategies. This course focuses on the computational design and the alternates 
that we can get from Fractal. 

A computational design model represents a space of alternatives by describing a configuration 
of variables, ranges, and relationships. It assumes that the optimal alternative for a design 
problem exists within the permutations made possible by the model. It is therefore crucial to 
define this information collaboratively, and iteratively. Finding an optimal solution within these 
boundaries does not necessarily represent the absolute optimal, since it is only the best design 
alternative derived from the model. A richer exploration can be achieved by exploring variations 
of different general configurations and intentionally manipulating the boundaries of the design 
space. Examples of alternatives: 

• Alternative 1: Building Orientation = 45, Window Width = 20 ft. (6.09 m.) 

• Alternative 2: Building Orientation = 45, Window Width = 15 ft. (4.572 m.) 

• Alternative 3: Building Orientation = 30, Window Width = 15 ft. (4.572 m.) 

Variables 
Variables correspond to the set of inputs that drive the computational of design alternatives. The 
variables range from those that trigger geometric variation of the parametric model. Examples of 
variables: 

• Window Wall Ratio (percentage) 

• Window Width (feet) 

• Building Length (feet) 

Dependent Variables 
In any design space, there are relationships between input and derived parameters. Derived 
parameters depend on input parameters controlling the size of both Wall and Window 
components. Examples of dependent variables in the Sprout Space model are: 

• Floor Area 

• Wall Surface Area 
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Ranges 
Ranges define the breadth of acceptable input variable values by defining their lower and upper 
bounds and increment intervals. Due to the size and complexity of the design spaces, analyzing 
every possible design alternative can often be an impossible task. Specifying the range for each 
variable makes searching design solutions more efficient. Examples of ranges: 

• Building Length (feet) = 32, 37, 42 

• Window Width (feet) = 1, 5, 9 

Impacts 
Once stakeholders have defined objectives and designers have computational design 
alternatives, the next step is to determine the performance impact of each alternative on each 
Objective, see Figure 1.1. The impact is the amount of influence the combined variables in an 
alternative have on the performance of an objective. Example of impacts of variables over 
indicators. 

 

 

Figure 1.1: Visualization of the impact of the variables on indicators with Fractal 

Value 
The next steps require assessment of a Value for every design alternative so that they can be 
rationally compared, and choices made. Formulation of an effective value function is usually an 
iterative process of narrowing and expanding the search as decision makers, stakeholders, and 
designers learn more about the space and their own preferences. Depending of the preferences 
of the stakeholders and the accuracy of the analysis methods, different alternatives can score 
the highest value with different levels of certainty of their indicators. The process of sorting and 
prioritizing the design alternative, see Figure 1.2 should include the following steps: 
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• Ordering of alternatives according to their performance on each objective 

• Ordering of alternatives with respect to goals, priorities, and certainty for each 
stakeholder 

• Ordering of alternatives with respect to goals, priorities, and certainty for all 
stakeholders 

 

 

Figure 1.2: Selected alternative according to value from Fractal 

Case Study: Sprout Space 
Sprout Space is a flexible, modular, and mobile class room developed by Perkins + Will, see 
Figure 2. Sprout Space provides the case study to explain a multi-criteria design, optimization 
and decision-making workflow. 

• Annual high temperature 71.7 F° 

• Annual low temperature 55.9 F° 

• Average temperature 63.8 F° 

• Climate zone 3B 
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Figure 2: Sprout Space, 16315 Grevillea Ave. Los Angeles, CA. 

Computational Workflow 
The integration of their parametric model with analysis tools allows analyzing, evaluating and 
visualizing the performances of different alternatives in a design space and compare them 
based on their performance metrics. The computational workflow has three stages: computation 
of design alternatives that are based on a dynamo studio graph, performance analyses based 
on energy, view analysis, and visualization that shows the input variables and the resulting 
indicator for energy use, solar analysis, daylight factor, direct line of sight and quality view, see 
Figure 2.1. 

 

Figure 2.1: Compressed example of the Sprout Space workflow 

Geometric Variables 
Table 2 shows an example of how to define the main driving variables, metrics, their realistic 
ranges within the theoretical ones, and, in the last column, the number of options of every 
variable for this case study that combined produce 216 design alternatives. This information is 
needed to help us to determine the input needs for the Dynamo graph, the range of those 
values, what is realistic to that value range, and finally how many Fractal options. Understand 
the more options to these inputs the more alternates we will see from Fractal, which can be over 
9 million! 
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Table 2: Geometric variables 

Variable Metrics Range Realistic Range Options 

Classroom Width feet 10 -24 12 1 

Classroom Length feet 32 - 42 42 1 

Classroom Height feet 10 - 15 10 1 

Classroom Offset feet 0 - 60 0, 4, 12 3 

Classroom Orientation degree 0-360° 0 1 

Front Window Width feet 1 - 9 1, 5, 9 3 

Front Window Height feet 0.1 - 1.0 0.4, 0.7, 1.0 3 

* Window Wall Ratio Left % 0 - 1 0.58 1 

* Window Wall Ratio Right % 0 - 1 0.411 1 

Roof Angle degree 0 - 10 0.5, 5 2 

Overhang Depth feet 0 - 3 0, 1, 2, 3 4 

Clerestory Width % 
0 - 
1.828 

1.2 1 

Clerestory Height % 10 - 75 60 1 

Clerestory Spacing feet 0 - 1 0.142 1 

Number of Panes unit 0 - 12 7 1 

(*ENERGY STAR) 
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Alternative Generation 

 

Figure 3: The Sprout Space Computational Design Space of Many Alternatives using Fractal 

A design alternative consists of a selected group of options for every input decision variable, 
see Figure 3. 

This section introduces a simple parametric model that creates Alternatives with geometric and 
other outputs suitable for analysis. The project uses a definition script file written in the visual 
graphical language of Dynamo Studio and Dynamo for Revit. Dynamo is easy to learn and use 
and can drive an environment for collaboration. Once the script is uploaded to Fractal Live it 
generates Sprout Space alternatives consisting of project geometry based on length, width, 
height, roof slope and other inputs. Subsequent chapters analyze and then decide among these 
alternatives. 

Conceptual Model for Analysis 
The conceptual parametric model provided represents with simple geometry the fundamental 
features required by the analyses, see Figure 3.1. The Sprout Space Generator cluster uses 
mainly single surfaces to represent walls, floors, roof, windows and overhangs rather than fully 
over detailed objects, see Figure 3.2. Generally, when constructing a parametric model, a 
modeler strives to be complete in terms of representing all the objects required by the design 
(nothing less, nothing more), general enough to represent the design space of alternatives, 
effective to support the geometric variations and efficient in terms of the use of computational 
resources. 

 

Figure 3.1: The Sprout Space Conceptual Model 
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Figure 3.2: Sprout Space Generator cluster 

Input Parameters 
Several input geometric parameters from the problem formulation drive variations of the model. 
The variables are organized in four groups that control the building massing, windows, roof and 
clerestory. 

Building Parameters 
The basic building block for the project consists of two similar classroom bars that join and 
share a common wall with an offset. The Dynamo script provides fine control over the classroom 
net area with width, length, height, offsets, and orientation, see Figure 3.3. Orientation will be 
best used once we bring the model into Revit and use Insight to check the energy performance. 
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Figure 3.3: Basic building configuration parameters 

Windows Parameters 
The model uses a set of sliders to vary fenestration geometry, with independent control of the 
left and west window to wall ratio, see Figure 3.4. 

 

Figure 3.4: Fenestration Parameters 

Roof and Overhang Parameters 
The project uses single sloped roof geometry for each class room bar, see Figure 3.5. The 
overhang depth variable provides a variable feature for self-shading and aesthetics. The roof 
fascia geometry parameter delivers additional geometric variation.  

 

Figure 3.5: Roof and Overhang Depth Parameters 

Clerestory and Pane Parameters 
The project features a clerestory design option for delivering natural daylight into the class room 
spaces. The parameters define the width, and height, see Figure 3.6. Clerestory spacing, and 
number of panes parameters provide control over the geometry generation.  
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Figure 3.6: Clerestory Geometry Parameters 

Development of Dynamo Graph 

Sprout Space Dynamo Graph 
The Dynamo graph that was produced for this workflow will require an intermediate knowledge 
of Dynamo, see Figure 4.0. With that said, if you have started to work with Dynamo and have 
produced some of your Dynamo graphs you should start to understand the logic behind the 
process. With the understanding of this logic you can easily start developing your own geometry 
shapes and based on your own input controls. 

 

Figure 4.0: Sprout Space Dynamo graph 

Design Alternatives Generation 
The Sprout Space Dynamo Graph aggregates single or multiple alternative inputs, and routes 
it to the preview window either in Dynamo Studio (single) or Fractal Live (multiple) to show the 
final solution. In the below section we manually change the inputs and used the Run button to 
see one solution at a time. With the use of Fractal Live we can run the same Dynamo graph but 
see multiple alternates at the same time. 
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Figure 5.0: Seeing multiple alternates from the same dynamo graph; total of 216 

Generation of a Single Alternative 
The use of individual set of parameters provides for a single design alternative in Dynamo 
Studio, see Figure 5.1. Single alternative groups all of the options for the class room geometry, 
fenestration, roof, overhang parameters.  

NOTE: Dynamo Studio is “unitless”, so “1” can mean “1” foot or “1” meter. There are two graph’s 
setup for the initial start of this workflow that have the “default” values setup correctly; Sprout 
Space Geometry Default_Values_I.dyn and Sprout Space Geometry Default_Values_M.dyn. 
This entire document set is using the “imperial” Dynamo graph; Sprout Space Geometry 
Default_Values_I.dyn. 

 

Figure 5.1: Parameters for a single alternative 
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Generation of Multiple Alternatives 
The “Fractal Live” website provides an efficient workflow for entering multiple options for a 
unique parameter, and for very large design space exploration. Each single option is sent for 
analyses in a sequence. The number of options can easily exceed hundreds of iterations, so the 
feature should be used judiciously. 

To try Fractal Live with a Dynamo graph for “multiple alternates”, open the “Sprout Space 
Geometry Default_Values_I.dyn” in Dynamo Studio. From the File drop-down use, the “send to 
web” option to publish the Dynamo graph to Fractal Live. Give it a name of “Sprout Space” and 
pick Publish, see Figure 5.2. 

 

Figure 5.2: Dynamo Studio Graph to Fractal Live 

Pick on the this LINK to go to the Autodesk Fractal Live website. You will need to pick on “My 
Workspaces” which will require a login before you can use it, see Figure 5.3. 

 

Figure 5.3: Fractal Live and My Workspaces 

Once you login it will show all of the current published Dynamo graphs from Dynamo Studio. 
Select on the Sprout Space dynamo graph to open it, see Figure 5.4. 

https://home.fractal.live/
https://home.fractal.live/
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Figure 5.4: Fractal Live published dynamo graphs 

Figure 5.5 shows an example of the automation process of the “window width” variable. 
The variable has a list of three possible options indexed from 0 to 3, The variable ranges from 1' 
to 3'. The Item component pulls out a different option from the list every time the “Front Window 
Width” option slider is updated. This process applies to automate the exploration of 
every variable. Noticed that if nothing is changed as for “variations” or the check marks left On, 
that there are 9.5 million alternates! 

 

Figure 5.5: Automation of multiple options per variable 

Design Space Matrix 
The above automation process creates all possible combination of variables. A simple example 
shows two variables that have a mix of variables (Table 4). The first variable uses a set of 
values from 'a' to 'c' . The second one contains values from '1' to '3'. The combination of these 
two variables creates a matrix which is a set of rows and columns. This matrix is expressed as a 
'3 x 3' set. The total possible combination for this set of variables is a design space of a list of 
nine runs (Table 2.2). The design alternatives and the “Fractal Live” website works in this way to 
create potentially thousands of options. In this case; 9,565,938 to be exact, see Figure 5.4. 

 

 

 

https://home.fractal.live/
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Table 4: Matrix of variables 

Variable 1 Variable 2 

a 1 

b 2 

c 3 

 

Table 4.1: Iteration run design set 

Iteration Design Space 

1 a,1 

2 a,2 

3 a,3 

4 b,1 

5 b,2 

6 b,3 

7 c,1 

8 c,2 

9 c,3 

Filter Variations 
Earlier we showed “Table 2” and the variations that we would like to use to see the different 
alternates. We will need to change the “variations” accordingly to filter down the designs from 
9.5 million to more reasonable 216 designs. 

Starting from the top input these values and change the option it uses variations:  

NAME VARIATIONS VALUE VARIATIONS USEAGE 

Length 42 No Check Mark 

Width 12 No Check Mark 

Height 10 No Check Mark 

Offset 12 3 Variations 
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Orientation 0 No Check Mark 

Roof Angle 5 2 Variations 

Roof Overhang 3 4 Variations 

WWR – Left 0.58 No Check Mark 

WWR – Right 0.411 No Check Mark 

Front Window Height 0.7 3 Variations 

Front Window Width 1 3 Variations 

Clerestory Height 0.6 No Check Mark 

Clerestory Width 1.2 No Check Mark 

Clerestory Quantity 7 No Check Mark 

Clerestory Spacing 0.142 No Check Mark 

 

The values should now match in Fractal, see Figure 5.5. 

 

Figure 5.5: New values added, and variations updated 

Now select the “Generate” button to start Fractal on working out the different values, build the 
different models, and update the graph to graphically show the variations, see Figure 5.6. 
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Figure 5.6: 216 alternates created from variations 

Filter Design Alternates 
To filter the 216 alternates, you can use the graph which has a dynamic interface to it. Let’s use 
the Front Window Height as a filter, pick and drag within the column on the graph. A selection 
window will be generated to highlight the selection, see Figure 5.7. 

 

Figure 5.7: Filtering variations using the interface of the graph 

Use the same approach on some of the other columns and notice the variations that are shown 
is getting smaller based on these filters. If you need to clear a filter just select the edge of the 
box and move it to the top or bottom so the box collapses, see Figure 5.8. 



 
 

 

Page 31 

 

Figure 5.8: Less variations being shown using the filters on the columns 

With this method you can start to determine what alternates might best fit the design intent for 
form and shape. From here you can start selecting some of your favorites by picking on the 
“star” in the top left corner of the preview, see Figure 5.9. 

 

Figure 5.9: Using the Favorite option for sorting 

You can also move the columns around on the graph if you would rather see some columns 
closer to each other, see Figure 5.10. 
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Figure 5.10: Shifting columns on the interface of the graph 

Fractal – Export Favorite Designs 
Once you have filtered out your “favorites”, see Figure 5.11, we can start downloading the new 
Dynamo graph’s, these will have the inputs already defined based on the “favorites” data. Once 
we download them we can then use “Dynamo for Revit” to build the Revit mass models. 

 

Figure 5.11: Using favorites to sort the computational models 

With the “is favorite” selected, use the “download” button to download the Dynamo graph that 
has those value inputs set as a default, see Figure 5.12. 

0. 

 

Figure 5.12: Download and save individual Dynamo graphs 
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You can also download a CSV file that has the entire set of design options in a table format for 
other purposes, see Figure 5.13. If you have used the “sort by” for your favorites, then those 
values will be at the top of the table. 

 

Figure 5.13: Download and save Dynamo graphs in table format 

Section 2 – Early Design Modeling 

 

Figure 1: A Sprout Space Design, as constructed. 

Overview 
When we run an energy simulation we are first creating a mass model from a Dynamo graph. 
This graph is either from your own single alternative from Dynamo Studio or a series of multiple 
alternatives from Fractal Live. Either way, we will be converting those surfaces over to Revit 
building elements to develop the energy model. We will use this same model to do daylighting, 
direct line of sight, and view quality analysis. 

A compressed example workflow is shown below, see Figure 1, while the next sections will 
detail the Energy Modeling section of the Sprout Space workflow. A more compressive workflow 
outline is shown in the PDF called “P+W Generative Process” as part of the “resource” package. 
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Figure 1.0: Compressed example of the Sprout Space computational workflow 

In this section we will look at how to bring the computational design favorites into Dynamo for 
Revit to create the mass models. Once the mass models are created we will walk-thru the 
process of converting the mass models to Revit building elements. Below is a quick overview. 

Windows 
These surfaces are required to add the curtain glazing elements of the front, side, and 
clerestory windows once the mass model is inside Revit, see Figure 6.0.  

 

Figure 6.0: Glazing areas 

Shading Surfaces 
Shading surfaces compute areas of the building under direct solar radiation, see Figure 6.1. 
Once in Revit as a mass model we will add roof elements to the surfaces. 

 

Figure 6.1: Shading areas 
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Partitions 
Once we create a mass model in Revit we add a wall partition which is required to subdivide the 
space to properly calculate the dark areas of the building that have no exterior view, when 
performing the quality view analysis and daylighting analysis, see Figure 6.2.  

 

Figure 6.2: Wall partition between zones of the building 

Envelope Geometry 
Like Figure 6.2, the view quality analysis needs the complete geometry of the envelope of the 
building including walls as closed planes with co-planar windows, roof and floor to identify the 
glazing areas required to perform the analyses. 

Dynamo to Revit Mass Family 
These next steps show the conversion from a Dynamo mass model to Revit building 
components. Using Revit start a new “conceptual mass family” (Mass.rft). If you are using metric 
then use the “conceptual mass family” (Metric Mass.rft). Using Dynamo for Revit run the graph 
to create the mass and save the family, see Figure 1.3 / 1.4. 

 

Figure 1.3: Dynamo for Revit graph using mass family template 
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Figure 1.4: The resulting representation of the geometry of a Dynamo graph 

Dynamo Graph to Mass Family 
We will need open Revit and start a new “Conceptual Mass” family. This can be done by 
selecting “File” on the ribbon, selecting New, and Conceptual Mass, see Figure 1.5. 

  

Figure 1.5: Start a new mass family 

On the ribbon select Manage and select Dynamo, this will start Dynamo for Revit and open a 
separate window, see Figure 1.6.  

 

Figure 1.6: Open Dynamo for Revit 
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Select Open and browse to the folder that holds one of the download Dynamo graphs that we 
did earlier with Fractal form section 1, see Figure 1.7. 

 

Figure 1.7: Open Fractal design alternate Dynamo graph 

Using the navigation tools at the top right you can zoom and pan either the Dynamo graph or 
the drawing window. Select the “Run” button to have Dynamo build the Mass in Revit. Once 
done go ahead and close Dynamo without saving, see Figure 1.8. 

 

Figure 1.8: Use the Run button to create the mass in Revit 

Load Mass into Project 
With the mass now created from the Dynamo graph go ahead and save the mass family, call it 
the same name as the Dynamo graph “SSG_Design-1”. In Revit start a new project for this 
design study using the supplied template called “Revit Model Template.rte”. To do this select 
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“File” on the ribbon, select New, and select Browse to go to the appropriate folder that has the 
dataset files, See Figure 1.9. 

 

Figure 1.9: Start new project using supplied Revit template 

Leave the new project open and use the keyboard combo of Ctrl+Tab to go back to the mass 
family. We need to import the mass family into Revit by using the “load into project and close” 
button to finish, see Figure 1.10. 

 

Figure 1.10: Mass family being loaded into project 
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Once you are in the project you will get a warning about enabling the Show Mass mode. This 
needs to happen so you can see the Mass family once it is inserted, select Close to accept the 
new display setting. Also, you will need to pick a point in the drawing window to place the mass 
family, so it is in your project. Once done then go ahead and hit the Escape key twice to finish. 
Lastly, a warning will come up about the mass contains mesh, this is because of how the 
Dynamo graph created the geometry, this is fine for our usage. Go ahead and hit the red X to 
close it, see Figure 1.11. 

 

Figure 1.11: Warnings when inserting the mass family into a project 

Select the newly loaded mass and add one mass floor, see Figure 1.12. 

 

Figure 1.12: Adding mass floor 

Add Curtain Wall Glazing to Surfaces 
Using the Massing & Site tab you will use the Curtain System tool to apply glaze onto the 
surfaces of the mass. In this case we are using a type that has no divisions or frames, see 
Figure 1.13. 
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Figure 1.13: Steps to add glaze to the surfaces 

Adding Walls to Surfaces 
Repeat this process using the Wall tool from the Mass & Site tab. We will use the “Generic - 8” 
wall type, make sure the “Location Line” is set to “Finish Face: Exterior”. Also make sure to add 
a wall for the interior partition that separates the two rooms, see Figure 1.14. 

 

Figure 1.14: Applying walls to exterior surfaces along with the one interior surface 

Adding Roofs to Surfaces 
Repeat the process again for the roofs. In “properties” use the “Generic – 12” roof type and 
change the option to “faces at bottom of the roof” to apply it correctly. On the ribbon select 
Create Roof to finish, see Figure 1.15. 
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 Figure 1.15: Adding roof to surfaces 

Adding Floors 
Select the “Level 1” floor plan view and add a floor using the “pick wall” tool that encompasses 
the exterior of the building, select the green check mark to finish, see Figure 1.16. 

 

Figure 1.16: Add a floor to the building 

Adding Rooms 
Add two rooms, use the existing room definitions from the “options bar”, see Figure 1.16 / 1.17.  

 

Figure 6.17: Adding rooms to the model 

Energy Model Location 
The next 3 steps are the typical workflow when you want to create an energy model for analysis 
using Insight. Step 1: Set location, Step 2: Settings, Step 3: Create energy model, and Step 4: 
Generate analysis. 

On the Project Browser, under 3D Views, open the 3D Energy Model view. On the Analyze tab 
set the “location” to “16315 Grevillea Ave, Lawndale, CA 90260”, see Figure 1.18. 
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Figure 1.18: Set location for weather data 

Energy Model Settings 
On the Analyze tab change the Energy Settings so “Analytical Space Resolution” is set to 6” 
and “Analytical Surface Resolution” is set to 3”. Along with setting the “Perimeter Zone Depth” to 
0”. Because of how small the model is we need to change these settings to the minimum, see 
Figure 1.19. 

 

Figure 1.19: Changing the settings to work with the model size 

Create Energy Model 
On the Analyze tab pick on “Create Energy Model” to generate the energy model, by default it 
always uses or creates a view called “3D Energy Model, see Figure 1.20. 
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Figure 1.20: Creating the energy model 

Changing the View Display 

Currently the energy model view shows the building elements and the energy analytical 
surfaces. To best see the energy model, you can turn Off all of the model categories using 
“Visibility/Graphic Overrides” tool. Either type in “VV”, “VG”, or go to the Properties palette and 
in the Model tab take the check mark Off for “Show model categories in this view”, see Figure 
1.21. 

 

Figure 1.21: Turning Off the model categories to best see the energy model 



 
 

 

Page 44 

Develop Insight Analysis 
With the energy model now created when need to upload it to Insight to do the energy analysis. 
From the Analyze tab select “Generate” to upload the energy model to Insight, see Figure 1.22. 

 

Figure 1.22: Uploading the energy model to Insight for energy analysis 

You will get some final messages, the first one select “Use existing Energy Analytical Model”, on 
the second one simply select Ok, see Figure 1.23. 

 

Figure 1.23: Final messages before uploading to Insight 

Design Alternates 
In section 1 we used Fractal to create at least 5 favorites, we have now completed one of those 
design alternates. You will need to repeat the above processes to finish the other 4 design 
alternates, see Figure 1.24.  

 

Figure 1.24: All design alternates uploaded to Insight 
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Section 3 – Energy, Daylighting, View, and Solar Analysis 

 

Figure 1: A Sprout Space Design, as constructed. 

Energy Analysis 

 

Figure 1.1: Energy analyses of Sprout Space alternatives 

An energy simulation calculates the heating and cooling energy required to keep the building at 
a comfortable temperature throughout the year (typically this means keeping the building 
between 19 C and 26 C). Each simulation we can define the attributes of each design in terms 
of their PV, internal loads, occupancy scheduling, and the material properties of the design. 

Energy simulation uses details of the spaces, building constructions, and weather data to 
calculate the temperature inside each room for every hour of the year (8760 hours) to calculate 
the heating and cooling energy required to keep the temperature inside each room comfortable 
when people are using each room. 

The Autodesk Insight cloud tool used in this course is simply an interface to two engines called 
DOE-2.2 and EnergyPlus, which does the calculations described above. Both have been tested 
against ANSI/ASHRAE 140. 

Insight will measure performance against Architecture 2030 and ASHRAE 90.1 benchmarks, 
making early targeting and feasibility seamless. Insight also links to AIA 2030 Design Data 
Exchange for easy transfer of data and filling the forms. 

Install Insight Plugin 
Regardless of the type of analysis you wish to do, to get started with Insight Solar Analysis with 
Revit, you should install the most recent version of the Insight plugin. 

http://www.doe2.com/
https://energyplus.net/
http://architecture2030.org/
https://2030ddx.aia.org/users/sign_in
https://2030ddx.aia.org/users/sign_in
https://insight360.autodesk.com/oneenergy/Landing/Download
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Insight Energy Analysis 
I assume that you did the previous section and have an Insight project to work with. In Revit, on 
the Analysis tab pick on “Optimize” to open the Insight analysis, see Figure 1.7. You can also go 
directly to the website; insight360.autodesk.com and sign in using your Autodesk Account 
information.  

 

Figure 1.7: Opening the Insight website 

Interface 
On the interface there is 5 main items to know about. (1) Understand your design’s Energy Cost 
or EUI, (2) The key factors driving building energy performance, (3) Use the factor ranges to 
explore different outcomes and sensitivity, (4) Save scenarios and compare those scenarios to 
visualize potential energy savings, (5) Visualize PV energy generation potential and heating and 
cooling loads in your model context, see Figure 1.8. 

 

Figure 1.8: The 5 main areas of the Insight interface 

https://insight360.autodesk.com/
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Adding Scenario 
When first looking at the energy model we need to add a “default” scenario to capture the initial 
settings before making any changes. This way we can see how the energy model is 
progressing, and if needed, be able to go back to the original settings, see Figure 1.9. 

 

Figure 1.9: Adding the default scenario 

Let’s add one more where the photovoltaics (PV) is not being counted by default. Scroll-down to 
the bottom and select “PV – Surface Coverage” to open the tile. Select it and change the sliders 
so it is set to “0%” for PV, see Figure 1.10. 

 

Figure 1.10: Changing the PV to 0% 
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Now go back up to the top and create a new “Scenario” and call it “Default – PV”, see Figure 
1.11.  

 

Figure 1.11: Adding new Scenario with PV set to 0% 

Select each one to note the huge difference in the energy usage between using PV and not 
using PV. If you are looking at SSG_Design-1 the setting goes from 13.8 to 23.7.  

Updating Settings 
Scroll down to the WWR – Sourthern Walls tile and select the “circle arrow” at the top right 
corner to open it. The values that show “BIM” are the Dynamo values that came from the Revit 
Model. So, the Window-Wall-Ratio (WWR) is exactly what was used in the Dynamo graph when 
we converted it to Revit building elements. You can see by the graph if there is a better value to 
use or if you add a percentage increase what it will do to the energy performance, see Figure 
1.12. 

 

Figure 1.12: Seeing the (WWR) and its effect on energy performance 
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Material Properties for LA, CZ3 
Below are the values that we will changing in Insight to reflect the ideal data that we would like 
to use for this design. These material values will be used in Insight to help show the progression 
of the energy range though the scenarios that we will develop. We will use the “Default” 
scenario as the baseline and as we add these values you will see the energy performance 
increase. Table 2.1 Shows the specification of material properties of the components of the 
Sprout Space located in Los Angeles Climate Zone 3 according to the recommendation of 
ASHRAE 90.1. The values in “RED” are the ones we need to use, the value of “BIM” is coming 
from the Dynamo graph. 

Table 2.1: Material properties - (*Min 28%, Preferred 40-60%) 

Properties Imperial Units option SI Units option Used by 

Building 
Orientation 

Real Number (0-
315) 

270 
Real Number 
(0-315) 

270 
Energy 
Model 

WWR - Southern 
Walls 

Real Number (0-
95) 

3 
Real Number 
(0-95) 

BIM 
Energy 
Model 

Window Shades - 
South  

Real Number (1/6-
2/3) 

1/4 
Real Number 
(1/6-2/3) 

BIM 
Energy 
Model 

Window Glass - 
South  

U-Value 
(kBtu/hr_ft2) 

Dbl Clr 
U-value 
(kWh/m2) 

Trp LoE 
Energy 
Model 

WWR - Northern 
Walls 

Real Number (0-
95) 

3 
Real Number 
(0-95) 

BIM 
Energy 
Model 

Window Shades - 
North 

Real Number (1/6-
2/3) 

1/4 
Real Number 
(1/6-2/3) 

BIM 
Energy 
Model 

Window Glass - 
North 

U-Value 
(kBtu/hr_ft2) 

Trp LoE 
U-value 
(kWh/m2) 

Trp LoE 
Energy 
Model 

WWR - Western 
Walls 

Real Number (0-
95) 

32 
Real Number 
(0-95) 

BIM 
Energy 
Model 

Window Shades - 
West 

Real Number (1/6-
2/3) 

1/4 
Real Number 
(1/6-2/3) 

BIM 
Energy 
Model 

Window Glass - 
West 

U-Value 
(kBtu/hr_ft2) 

Trp LoE 
U-value 
(kWh/m2) 

Trp LoE 
Energy 
Model 

https://bernalm.gitbooks.io/design-space-construction/content/GLOSSARY.html#option
https://bernalm.gitbooks.io/design-space-construction/content/GLOSSARY.html#option
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Properties Imperial Units option SI Units option Used by 

WWR - Eastern 
Walls 

Real Number (0-
95) 

14 
Real Number 
(0-95) 

BIM 
Energy 
Model 

Window Shades - 
East 

Real Number (1/6-
2/3) 

1/4 
Real Number 
(1/6-2/3) 

BIM 
Energy 
Model 

Window Glass - 
East 

U-Value 
(kBtu/hr_ft2) 

Trp LoE 
U-value 
(kWh/m2) 

Trp LoE 
Energy 
Model 

Wall Construction 
- Walls steel 
framed 
(Cavity+continuou
s insulation) 

U-Value 
(kBtu/hr_ft2) 

R13 
Metal 

U-value 
(kWh/m2) 

R13 Metal 
Energy 
Model 

Roof Construction 
- Metal 
(Continuous+cavit
y insulation) 

U-Value 
(kBtu/hr_ft2) 

R38 
U-value 
(kWh/m2) 

R38 
Energy 
Model 

Infiltration 
(ACH) Real 
Number (0.17-2.0) 

0.4 
(ACH) Real 
Number (0.17-
2.0) 

0.4 
Energy 
Model 

Lighting Efficiency w/sf 0.7 W/m2 7.53 
Energy 
Model 

Daylighting & 
Occupancy 
Controls 

kBtu 

Daylightin
g & 
Occupan
cy 
Controls 

kBtu 

Daylightin
g & 
Occupanc
y Controls 

Energy 
Model 

Electric Plug 
Loads 

w/sf 1.0 W/m2 10.76 
Energy 
Model 

HVAC System kBtu 
High Eff. 
Heat 
Pump 

kBtu 
High Eff. 
Heat 
Pump 

Energy 
Model 

https://bernalm.gitbooks.io/design-space-construction/content/GLOSSARY.html#option
https://bernalm.gitbooks.io/design-space-construction/content/GLOSSARY.html#option
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Properties Imperial Units option SI Units option Used by 

Operating 
Schedule 

Seasonal, Annual, 
School Year, 
Daily, Weekend 

12/6 

Seasonal, 
Annual, School 
Year, Daily, 
Weekend 

12/6 
Energy 
Model 

PV – Panel 
Efficiency 

range (16-20.4) 18.6 range (16-20.4) 18.6 
Energy 
Model 

PV – Payback 
Limit 

range (10-30) 20 range (10-30) 20 
Energy 
Model 

PV – Surface 
Coverage 

range (0-90) 60 range (0-90) 60 
Energy 
Model 

Assumptions 
The table below is for reference. Some input variables of the generative and evaluation 
processes become constants based on assumptions (Table 1.4) usually derived from the 
regulations and best practices. 

Table 1.4: General assumptions 

Variable 
Imperial 
Units 

Option SI Units option Used by 

Air Changers Per Hour 
(Infiltration) 

ac/hr 0.6 ac/hr 0.60 
Energy 
Model 

Ventilation Rate per Area cfm/ft2 0.117884972 m3/m2S 0.0006 
Energy 
Model 

Ventilation Rate per Person cfm/ft2 0.982374768 m3/m2S 0.005 
Energy 
Model 

HVAC heating set point °F 64 °C 18.00 
Energy 
Model 

HVAC cooling set point °F 79 °C 26.00 
Energy 
Model 

HVAC heating setback set 
point 

°F 73 °C 12.00 
Energy 
Model 

https://bernalm.gitbooks.io/design-space-construction/content/GLOSSARY.html#option
https://bernalm.gitbooks.io/design-space-construction/content/GLOSSARY.html#option
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Variable 
Imperial 
Units 

Option SI Units option Used by 

HVAC cooling setback set 
point 

°F 90 °C 32.00 
Energy 
Model 

*Wall Reflectance 0-100% 70% 0-100% 0.70 
Daylight & 
Energy 

*Ceiling Reflectance 0-100% 70-90% 0-100% 
70-
90% 

Daylight & 
Energy 

*Floor Reflectance 0-100% 20% 0-100% 0.20 
Daylight & 
Energy 

(*ASHRAE/IES Advanced Energy Design Guides) 

Table 2 Inputs 
Using the values from Table 2 to update the tiles from the default settings, notice how the 
energy performance model updates and shows real-time results, see Figure 1.13. 

 

Figure 1.13: Updating tiles to the new values and seeing real-time updates 

http://www.lightnowblog.com/2010/11/ashrae-recommended-surface-reflectances/
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Create another “Scenario” and called it “Table 2 Inputs”, see Figure 1.14. 

 

Figure 1.14: New scenario with Table 2 inputs added 

Comparing Results 
Select scenario “Default” and notice the energy performance = 13.8, see Figure 1.15. Change 
the scenario to “Default – PV” and notice the energy performance = 23.7. Finally change the 
scenario to “Table 2 Inputs” and notice the energy performance = -9.99, see Figure 1.16. With 
these settings we have a “Negative Net Zero” energy building. 

 

Figure 1.15: Default settings from Revit model (BIM), better than ASHRAE 90.1 
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Figure 1.16: Values from Table 2, better than ARCHITECTURE 2030 

You can also see and compare the results side-by-side using the “Scenario Compare” tool, see 
Figure 1.17.  

 

Figure 1.17: Compare results side-by-side 
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Export Options 
By selecting the “Back to Insight” at the top left you can get to these settings, see Figure 1.18.  

 

Figure 1.18: Getting to export options 

Export Files 
From Insight you can “export” multiple different formats of the energy model data, see Figure 
1.19. This includes CSV, EnergyPlus, GBXML, DOE-2, and images. Note you can take this data 
directly into AIA DDx to fill out the reporting forms for the project, see Figure 1.20. 

 

Figure 1.19: Export options from Insight 

Using the “Export” brings up an additional dialog box to select multiple different formats, see 
Figure 1.20. 

 

Figure 1.20: Download the other formats 
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Export AIA DDx 
Measuring progress on carbon neutrality is a complex task that can take time away from firm 
capacity. AIA helped develop the 2030 Design Data Exchange (DDx) to make it easier and 
faster to record data, get results and advance your firm’s performance with actionable 
information. 

The confidential, easy-to-use DDx lets you pinpoint best practices and anonymously compare 
project performance in your firm and beyond. The research tool allows you to compare projects 
of similar type, size, climate and a host of other attributes across the 2030 portfolio. 

AIA developed the DDx with support from the US Department of Energy and in partnership with 
Architecture 2030 and the US Environmental Protection Agency—and with guidance from a 
diverse group of experienced 2030 firm users. Using the “Report to AIA DDx” tool will bring you 
to the DDX website for reporting, see figure 1.19 / 1.21. 

 

Figure 1.21: Energy data reporting to AIA 

Model Comparison 
Since you created some Scenarios in the first Design analysis you can use those same settings 
on the other models for a quick comparison. On the “Model Comparison” palette select the 
“Scenarios “custom” drop-down, see Figure 1.22. 

 

Figure 1.22: Scenario model comparison   

https://www.aia.org/pages/5041-2030-design-data-exchange-ddx
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Select the “Star” next to the “Table 2 Inputs” to add it as a Favorite, see Figure 1.23.  

 

Figure 1.23: Add favorite to scenario model comparison   

Now select it to add those settings to all of the design models. Notice all of the design models 
have been updated with the new settings and show the new energy performance data, see 
Figure 1.24. 

 

Figure 1.24: Table 2 Inputs applied to all design models for comparison   
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Optimization for Detailed Architectural Model 
For your own projects that are using mass elements, or building elements, or a combination of 
the two, there are some items to be aware of. 

Perform the following steps in the order listed. 

1. Isolate elements that will be used in the creation of the energy model. 

2. Focus the model to minimize processing time. 

3. Identify and resolve issues, such as obvious missing elements and large gaps. 

4. Create the energy model and assess the results. 

5. Reduce resolution incrementally as needed. 

For more detail in this process look here - LINK 

Green Building Studio 
Autodesk® Green Building Studio (GBS) is a flexible cloud-based service that allows you to run 
building performance simulations to optimize energy efficiency and to work toward carbon 
neutrality earlier in the design process. Green Building Studio® will help extend your ability to 
design high performance buildings at a fraction of the time and cost of conventional methods. 

GBS is available as an extension of the Insight analysis and will give additional data and 
imagery if needed. You can login here using the same Autodesk Account that you used for your 
Insight analysis: LINK  

Daylight Analysis 

 

Figure 2.0: Heat map representing the daylight indicator of a design alternative 

The daylight simulation calculates the daylighting quantity and quality within the spaces of the 
building (Figure 2.0). This analysis calculates the Daylight Factor - the ratio between the interior 
and exterior illuminance levels of natural lighting. This plug-in provides “LEED IEQc8.1 
2009” and “LEED v4 EQc7 opt2” results for most models in less than 15 minutes once the 
analysis is started. The LA/R is specifically designed for architects to be able to use without 
learning the difference between the Perez or CIE's sky models, direct normal incident, or direct 
horizontal radiation. Just specify if you want to analyze the whole building, a single, or multiple 
floors, and kick-off the analysis. If you want more control of those parameters, you can use 
Revit's existing 360 Rendering Advanced Illuminance feature . 

http://help.autodesk.com/view/RVT/2018/ENU/?guid=GUID-32BD5A12-DF5B-4B51-B51A-D799C729A78A
https://gbs.autodesk.com/GBS/
http://help.autodesk.com/cloudhelp/ENU/BPA-PerformanceStudies/files/GUID-55433AEF-CA98-414A-90BB-E6C0FFD222B6.htm
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Analysis Type Description 

Illuminance Analysis Full custom control over date, time, threshold, and analysis plane 
height 

Daylight Autonomy (sDA 
preview) 

Sample calculation for LEED v4 EQc7 opt1 (sDA & ASE) 
Reduced cost & calculation time 

LEED 2009 IEQc8 opt1 Automated settings for LEED 2009 IEQc8 opt1 settings 

LEED v4 EQc7 opt1 Automated settings for LEED v4 EQc7 opt1 (sDA & ASE) settings 

LEED v4 EQc7 opt2 Automated settings for LEED v4 EQc7 opt2 settings 

Solar Access Customizable hours of sun study 

Daylight Simulation and Analysis 
Open “SSG_Design-1_Daylight.rvt” or one your Sprout Space building element models in Revit. 
Note that for lighting analysis studies, you must use one of the converted Revit models since 
these tools do not work with a conceptual mass model. Also, be sure to login to your Autodesk 
account within Revit. Lighting analysis consumes Cloud Credits, so Revit will need to be able to 
access your Autodesk account to complete the analysis. 

If you are using the “SSG_Design-1_Daylight.rvt” or one of your earlier models, the location 
should be set and along with a weather station being selected but make sure they are correct. 
From the Analyze tab, select Lighting from within the Insight panel, see Figure 2.1. 

 

Figure 2.1: Getting started with lighting analysis 

The first dialog that appears provides resources and best practices for conducting a lighting 
analysis study. These best practices are not required, but will help you achieve more accurate 
results, select Continue, see Figure 2.2. 

https://knowledge.autodesk.com/customer-service/account-management/subscription-management/subscription/cloud-services/autodesk-360-cloud-credits-faq
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Figure 2.2: Overview of lighting analysis tool 

Next, you will have the option to run a new analysis type or recall previously saved results. 
Select “Run New Analysis” and then pick Go, see Figure 2.3. 

 

Figure 2.3: Run new analysis 
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The “Lighting Analysis in the Cloud” dialog box will allow you to control your study settings, see 
Figure 2.4. 

 

Figure 2.4: Analysis settings 

1. “Analysis” allows you to select between different study types including: 

Analysis Type Description 

Illuminance Analysis Full custom control over date, time, threshold, and analysis plane height 

Daylight Autonomy (sDA 
preview) 

Sample calculation for LEED v4 EQc7 opt1 (sDA & ASE), Reduced cost & 
calculation time 

LEED 2009 IEQc8 opt1 Automated settings for LEED 2009 IEQc8 opt1 settings 

LEED v4 EQc7 opt1 Automated settings for LEED v4 EQc7 opt1 (sDA & ASE) settings 

LEED v4 EQc7 opt2 Automated settings for LEED v4 EQc7 opt2 settings 

Solar Access Customizable hours of sun study 

2. Select which “Levels” you would like to visualize results for using the drop-down menu, 
and double click on your selection. To select multiple levels, hold down SHIFT to select 
the levels, then click outside of the drop-down menu. 
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3. The “Environment” settings include location and analysis time or range. The location 
specified for the Revit project is what will be used for the analysis. The date and time 
settings are automatically populated for LEED analysis types, however if you select 
Illuminance Analysis or Solar Access, you have the ability control to the settings. 

4. The “Illuminance Settings” are also automatically populated based on LEED criteria, but 
can be manually controlled for “Illuminance Analysis” and “Solar Access” studies. 

5. The “Resolution” includes two analysis grid sizes; a 72 inch grid and 12 inch grid. For 
some analysis types, these grid sizes are preset and cannot be edited. 

6. Get an email or not when the analysis is done. 

7. Select “Check Price” and then “Start Analysis” to begin the simulation. 

After selecting “Start Analysis”, the model geometry will be uploaded to the cloud rendering 
engine. Do not close the project or Revit during this process. 

NOTE: You will get a dialog box once the model is successfully uploaded to the cloud and to 
notify you to Save the project. Once that happens it is okay to close the project or continue 
working in Revit.  

NOTE: That any changes you make to the model geometry or material settings will not be 
reflected in your analysis results, as the model has already been uploaded for analysis. 

You can check the progress of the analysis by initiating the plugin again and using the drop-
down menu to find in progress analyses, see Figure 2.5. 

 

Figure 2.5: Lighting analysis in progress 

Revit will notify you once the results are ready. “Accept” or “Decline” the cloud credit charges at 
this point, see Figure 2.6. It is recommended you also save the project after accepting the 
charges, so you will be able to recall the lighting analysis results after exiting Revit. 
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Figure 2.6: Accept lighting analysis results 

Visualization 
Open the “_Lighting Analysis Model” view under 3D Views, see Figure 2.7. Note that any 
“_Lighting…” views are automatically created to easily access results in plan, 3D, and as a 
schedule. Analysis results will populate in whatever 3D view is currently active. 

 

Figure 2.7: Lighting Analysis Model View 

From the Insight panel select “Lighting” to access your analysis results. This time, select the 
results for the analysis that has been completed and select “Go”, see Figure 2.8. 

 

Figure 2.8: Applying Lighting Analysis to the current view 
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You’ll be prompted with a dialog box with a summary of your results. If you are doing a LEED 
type analysis, then the amount of achievable points will also be included, see Figure 2.9. 

 

Figure 2.9: The Lighting Analysis results 

Within a 3D view, on the Properties palette, you can use the use the “Section Box” tool to view 
the results or you open the corresponding “_Lighting Analysis” floor plan, see 2.10. 

 

Figure 2.10: Plan view on the left and section box view on the right 

The “_Lighting Analysis” floor plans are only produced if rooms are placed for the levels, see 
Figure 2.11. 

 

Figure 2.11: Lighting Analysis plan view 

For analysis types that represent a single point in time, you can toggle between the two dates 
and times that were simulated by selecting the analysis plane and changing the “Analysis 
Configuration” in the “Properties” panel, see Figure 2.12. 
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Figure 2.12: Selecting lighting analysis “plane” and changing date 

Data 
Open “_Lighting Analysis Room Schedule”. If you define rooms, those rooms and corresponding 
analysis values will be populated here, see Figure 2.13. 

 

Figure 2.13: LEED v4 schedule in Revit 

LEED Studies (Single point in time) 
You can use Insight Lighting Analysis to determine your design’s progress towards achieving 
LEED daylighting criteria, specifically LEED 2009 IEQc8 opt1and LEED v4 EQc7 opt2. Both of 
these credits require specific illuminance levels at the equinoxes. 

To conduct either of these studies, follow the steps outlined in the Overview and take note of the 
following. 

When selecting either LEED analysis type, note that the majority of the analysis settings are 
preset according to the LEED specifications, see Figure 2.14. 

http://www.usgbc.org/credits/schools/v2009/ieqc81?view=language
http://www.usgbc.org/credits/healthcare/v4-draft/eqc-0
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Figure 2.14: LEED v4 settings 

1. The Location is set based on the Revit project location. 

NOTE: LEED single point in time analysis automatically use the Perez Sky model. 

2. LEED 2009 and v4 specify different thresholds, so you will see these values change 
depending on which version of LEED you choose for the analysis type. Additionally, 
LEED requires the analysis occur at 30 inches above the finished floor. The analysis 
plane automatically is generated at this height for LEED studies. 

When you generate the results in your Revit model, you will also get a summary of percentage 
of rooms passing and estimated LEED credit points the project is eligible for, see Figure 2.15. 

Analysis Type Description 

LEED 2009 IEQc8 
opt1 

As defined by USGBC, this simulation requires a clear sky condition within 15 
days of September 21 at 9am and 3pm. 

LEED v4 EQc7 opt2 As defined by USGBC, this simulation requires a clear sky condition and uses 
average weather data within 15 days of September 21 and March 21. 
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Figure 2.15: LEED v4 results 

It is often the case that you will want to exclude rooms that are not regularly occupied from the 
analysis so not to skew your results. You can control this through the schedule, see Figure 2.16. 

“Automated Shades” are also available to include and will extend the acceptance threshold, see 
Figure 2.16. 

 

Figure 2.16: LEED v4 schedule to include rooms or automated shades 

Any changes made in the schedule do not require you re-run the analysis. To “regenerate 
results” go to the ribbon, select the Analyze tab, and select “Lighting” again. This will regenerate 
results and will consider the new information updated in the schedule, see Figure 2.17. 

 

Figure 2.17: LEED schedule updated, and warning shown to regenerate results 

LEED sDA & ASE Studies (Annual simulation) 
You can use Insight Lighting Analysis to produce sDA and ASE results according to LEED v4 
EQc7 opt1. This credit requires annual simulation at an hourly time step. 

http://www.usgbc.org/resources/environmental-quality-space-type-matrix
http://www.usgbc.org/credits/healthcare/v4-draft/eqc-0
http://www.usgbc.org/credits/healthcare/v4-draft/eqc-0
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To conduct these studies, follow the steps outlined in the “Overview” and take note of the 
following. 

Similar to the LEED studies for a single point in time, many of the settings for this analysis type 
are automatically predefined, see Figure 2.18. 

 

Figure 2.18: LEED v4 settings 

1. The time range will be automatically set to a full annual simulation, from 8am to 6pm. 
LEED sDA and ASE studies automatically use the Perez Sky model. 

2. Per the LEED requirements, sDA300/50 for at least 55% or 75% regularly occupied floor 
area is achieved. Additionally, ASE1000/250 of no more than 10% for the occupied floor 
area that is daylit per sDA300/50. LEED requires the analysis occur at 30 inches above 
the finished floor. The analysis plane automatically is generated at this height for LEED 
studies. 

3. sDA and ASE calculations require at 24 inch analysis grid, which is automatically set. 

Since the sDA and ASE simulation is more intensive than a single point in time, the analysis will 
take more time than a single point in time analysis. 

Results summaries will provide guidance on how to improve design to achieve LEED 
requirements as well as more information about the metrics, see Figure 2.19. 
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Figure 2.19: LEED v4 sDA/ASE guidance 

Visual results and schedule results will present sDA300/50 and ASE1000/250 results, sDA and 
ASE Annual Hours, as well as combined metric results. Like before if you select the analytic 
surface you in the Properties palette you change from sDA Annual Hours to ASE Annual Hours, 
see Figure 2.20. 
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Figure 2.20: LEED v4 sDA/ASE results 

Since the sDA and ASE simulations are more computationally intensive than a single point in 
time analysis, the time will likely be greater than for other analysis types. The “Daylight 
Autonomy (sDA Preview)” study type will analyze a sampling of the 3650 hours used in the full 
LEED v4 EQc7 opt1 (sDA+ASE) analysis. The “sDA Preview” study type will run faster. Results 
will be in line with those from the full LEED v4 EQc7 opt1 (sDA+ASE) analysis. 

Export Data 
Any of the lighting analysis can be exported out to XML for additional usage. Open the lighting 
dialog box and select one of the analysis. Now use the “export” option at the bottom left to 
create the XML file, see Figure 7.20. 

 

Figure 7.20: Export lighting analysis to XML 

The lighting schedule in Revit can be exported as a tab delimited TXT file so the data can be 
used elsewhere. From the File drop-down use “export” to get to the “report” tool, see Figure 
2.22. 
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Figure 2.22: Export Revit schedule to tab delimited TXT file 

Quality View Analysis 
The purpose of View Quality analysis is to assure the connection with the outdoor environment, 
see Figure 3.0. This analysis entails two indicators: The Direct Line of Sight (DLS) that 
calculates the percentage of the floor area of the building with exterior view, and the Quality 
View (QV) that calculates the percentage of the area that allow the view of some relevant 
elements of the landscape. These two indicators are based on the Chapter Indoor 
Environmental Quality from the Guide for Building Design and Construction LEED V4 (Updated 
July 1, 2014). 

 

Figure 3.0: View quality (QV) and direct line of sight (DLS) analyses for design 1 

There are two Dynamo graphs that will be used for this process. Revit does not have such a 
feature built-in so hence the reason for the Dynamo graphs. Based on the knowledge learned in 
section 1 you can go in and see how the graph was built and modify it for your project. 
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Quality View Analysis Process 
This analysis takes the building envelope components as inputs and discriminate between 
opaque and glazing surfaces to calculate the two-different indicator: DLS and QV, see Figure 
3.1. 

 

Figure 3.1: Quality view Dynamo graph and main nodes 

Glazing and Opaque Areas 
The “Curtain Panels” component distills the glazing regions of the envelope that constitute the 
main input to calculate the DLS and the QV indicators. It takes in the geometry of the envelope, 
including wall, curtain panel, and interior partition geometry to identify the interior spaces, the 
plan perimeter, the glazing cells or surfaces, and the opaque walls with and without windows, 
see Figure 3.2. 

 

Figure 3.2: Glazing calculation 

Direct Line of Sight (DLS) Indicator 
The Dark Areas 

The extent of glazing, as viewed in plan, is used to determine the 'areas with no views'. This 
concept is taken from LEED 4.0: 

"Achieve a direct line of sight to the outdoors via vision glazing for 75% of all regularly occupied 
floor area. View glazing in the contributing area must provide a clear image of the exterior, not 
obstructed by frits, fibers, patterned glazing, or added tints that distort color balance." 

The method that calculates the floor area, is taken from LEED 2009 IEQ Credit 8.2 Daylight and 
views. In this method, the plan view angle through the glazed area considers the actual wall 
thickness for punched windows. In plan, two diagonal lines are drawn, one connecting the 
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exterior left wall opening corner to the interior right wall opening corner, and the other 
connecting the exterior right wall opening corner to the interior left wall opening corner. This is 
done for each glazed opening. These two diagonal lines are extended towards the interior. 
Wherever diagonal lines of adjacent windows intersect, the area contained within these diagonal 
lines and the associated wall or walls is regarded as an 'area with no view' or dark area, see 
Figure 8.3. The DLS indicator of this case study is 0.830265, or 85%, which is above the 
recommended reference of 75%, see Figure 3.3. 

 

Figure 3.3: Process of computing the dark areas of the building 

Duplicate Floor View 
To try this workflow, open “SSG_Design-1_Quality View” or one of the earlier Project design 
files and “duplicate with detail” Level 1 Floor Plan. We want to capture the room and room tag 
data for this new view. Rename it “Level 1 – Line of Sight”, see Figure 3.4.  

 

Figure 3.4: “Duplicate with detail” the Level 1 Floor Plan view, rename it 

Check View Range 
Can you see all of the windows in the floor plan for the DLS? If not, from the “Properties” palette 
using the “view range” dialog box, you will need to change the “cut plane offset” value, see 
Figure 3.5. 
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Figure 3.5: Changing the cut plane to see all of the windows 

Starting DLS Dynamo Graph 
Staying in the “Level 1 – Line of Sight”, on the ribbon go to the Manage tab and start Dynamo 
for Revit and open the “Direct Line of Sight” Dynamo graph and run it. Dynamo and the Revit 
view will update with the direct line of sight information, see Figure 3.6. 

 

Figure 3.6: Dynamo and Revit showing direct line of sight information 

NOTE: If you make changes to the model you will need to re-run the Dynamo graph. Before 
doing that make sure to delete the “Filled Regions” and “Text”. 

Quality View (QV) Indicator 
2D Visual Fields 

DLS assures people can see out of the building, but this says nothing about the quality of that 
view. The QV indicator is inspired by the Quality View definition in LEED V4. It is based on a 
two-dimensional interpretation of the building. It represents a 2D viewing angle from each 
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sampled view point inside the building, as it would be represented in a section, and computes 
the intersection of these 2D fields with relevant elements of the landscape, see Figure 3.0 / 3.7. 

 

Figure 3.7: Process of computing the 2D viewing angles 

Refer to the Guide for Building Design and Construction LEED V4 (Updated July 1, 2014) 
Chapter: Indoor Environmental Quality EQ Credit Quality Views, and see examples on pages 
750-751 for more information. 

Landscape Evaluation 
For the purpose of this case study, the triangular meshes representing the 2D viewing angles 
are used to intersect elements in the context model of two buildings masses of visual interest, 
see Figure 3.8. When an intersection is found, it is counted towards a quality view area, 
represented as a blue area on the center of the space. This method requires a mesh 
representation of the relevant elements of the landscape. The QV indicator of this case study is 
0.237862 that corresponds to almost 24% of the floor plan area of the building. 
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Figure 3.8: Computing and mapping in plan the intersection of the viewing angles with relevant 
elements of the landscape 

Duplicate Floor View 
For the Dynamo graph to work properly a view and “mass elements” need to be developed. 
Open “SSG_Design-1_Quality View “ or one of the Project Design files and “duplicate with 
detail” Level 1 Floor Plan. We want to capture the room and room tag data for this new view. 
Rename it “Level 1 – Quality”, see Figure 3.9. 

 

Figure 3.9: “Duplicate with detail” the Level 1 Floor Plan view, rename it 
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Create Site Elements 
On the “Architecture” tab choose the drop-down for “Component -> Model in Place”. Choose 
“Site” for the category and call it “Mass Site”, see Figure 3.10. 

 

Figure 3.10: Start the process of creating the site mass 

Use the “Extrusion” tool to create two masses that are located away from the Sprout Space. 
Change the “extrusion end” height to be 20ft, see Figure 3.11. 

 

Figure 8.11: Creating site mass with extrusion 

Starting QV Dynamo Graph 
On the ribbon go to the Manage tab and start Dynamo. Open the “View Quality” Dynamo graph 
and run it. Dynamo and the Revit view will update with the quality view information, see Figure 
3.12. 
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Figure 3.12: Dynamo and Revit showing view quality information 

3D View 
The 2D viewing angles are converted and shown in Revit. Change from the floor plan view to a 
3D view to see them in your Revit model. Change the “visual style” from “hidden” to “shaded” for 
a better visual (Figure 3.13). You can delete or hide them at any time when not needed. 

 

Figure 3.13: 2D viewing angles shown in Revit 

Change Dynamo Settings 
Back in the “View Quality” Dynamo graph you can change the “Eye Elevation” and “View Depth” 
if the 2D viewing angles need to be higher, shorter, or longer so it intersects the mass site 
elements (Figure 3.14). 
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Figure 3.14: Change eye elevation or view depth of 2D viewing angles 

Data Export 
Both Dynamo graphs create excel spread sheets and place them in the same folder from where 
you opened the graph, see Figure 3.15. 

 

Figure 3.15: Data from Direct Line of Sight and Quality of View 

Solar Analysis 
Overview 

Insight Solar Analysis provides in context solar radiation analysis results to help you track solar 
energy throughout your design. The plugin provides automated settings for specific study types, 
as well as customizable options. The following analysis types are currently available: 

 

Analysis Type Description 

Solar Energy – Annual PV Annual simulation for determining PV energy production estimates 

Custom Customizable simulation for general solar insolation studies 
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Insight Solar Analysis with Revit uses the Perez Solar Model, a calculation method that occurs 
locally within Revit. 

NOTE: For solar analysis studies you can use a conceptual mass, detailed building element 
model, or even a hybrid of the two. 

 

Validation 
Insight Solar Analysis with Revit uses the Perez solar model to calculate results. This model is 
used by the National Renewable Energy Lab (NREL) and their PVWatts® tool. Results from 
Insight Solar Analysis have been validated directly by NREL and findings conclude that 
differences between the results were less than 1% for surfaces oriented horizontal, east facing 
vertical, and south facing with latitude tilt angle. 

You can test solar analysis results yourself by analyzing a surface with specified tilt and 
orientation in PVWatts® for a TMY station and comparing results with Insight Solar Analysis 
with Revit for a location with the same TMY station. 

It’s important to note that Revit uses a variety of weather data for analysis, not just TMY data. 
Read more about the Revit Internet Mapping Service. When comparing Insight Solar Analysis 
results to those from other tools, consider weather data sources and varying calculation 
methods when comparing results. 

Getting Stated 
Open the “SSG_Design-1_Solar Analysis.rvt” file or open one of the Project Design files. Make 
that the “Location” is set before starting the Solar analysis. On the ribbon go to the Manage tab 
and select Location, see Figure 4.1. 

http://www.nrel.gov/
http://pvwatts.nrel.gov/
http://pvwatts.nrel.gov/
http://blogs.autodesk.com/insight360/climate-server-a-hidden-gem-in-gbs/
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Figure 4.1: Set location for solar analysis 

Start Solar Analysis 
On the ribbon go to the Analyze tab, select Solar from within the Insight panel, see Figure 4.1. 
The Solar command is a separate plugin you can download from here. 

 

 

Figure 4.2: Start the solar analysis 

The Solar Analysis dialog box will appear. This is where you can control your study settings, see 
Figure 4.3. 

https://insight360.autodesk.com/oneenergy/Landing/Download
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Figure 4.3: Solar analysis interface 

Options 
1. “Analysis” allows you to select between different study types including: 

 

Analysis Type Description 

Solar Energy – Annual PV Annual simulation for determining PV energy production estimates 

Custom Customizable simulation for general solar insolation studies 

 

2. Select which “Surfaces” you would like to visualize results for. There are two preselection 
options, and one customizable option. 

 

Surface Selection Description 

All Roof Exterior Surfaces When selected for a model with building elements, this option 
automatically selects all Roof elements 

All Mass Surfaces When selected for a model with conceptual masses, this option 
automatically selects all mass faces 

User selection This option allows you to select your own mass and building element 
surfaces for analysis 
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3. The “Results” dialog provides a summary of PV Energy Production or Insolation results; 
whichever study type is selected. These results become available once the analysis is 
complete. 

4. Study Settings summarize the area and time range selected for your analysis. To change the 
date and time range, edit the Sun Settings for the 3D view you have active, see Figure 4.4. 

 

Figure 4.3: Solar analysis interface 

5. You can expand Results Settings to define additional settings for analysis. 

 

 

1. The “Type” allows you to select between different analysis types: 

• Cumulative Insolation 

• Average Insolation 

• Peak Insolation 

You can also specify which units you would like to use for results: 

• Wh/m2 

• Wh/m2  

• BTU/ft2 

2. The “Style” controls the color scale and legend settings. Use the drop-down menu to 
select a different style or select the […] to create your own style. 

3. “Export” allows you to export results as a CSV. This option will be enabled once the 
analysis is complete. 

6. Once all settings are defined, you can select “Update” and the analysis will begin. The analysis 
happens locally (within Revit), and you will see a status bar indicating analysis progress. 

Results 
Once the analysis is complete, the “Solar Analysis” dialog will update with a results summary 
and results will appear in your active 3D view, see Figure 4.4. 

https://knowledge.autodesk.com/support/revit-products/learn-explore/caas/CloudHelp/cloudhelp/2017/ENU/Revit-Analyze/files/GUID-1074AB24-51A4-43BE-816B-BB2231D5C988-htm.html
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Figure 4.4: Solar analysis results 

To make any changes to the analysis settings, or select new surfaces for analysis, simply edit 
the settings or selections, and press “Update again”. New results will override previous results.  

NOTE: Solar analysis results cannot be saved with the Revit model. If you like certain settings 
take note of what those settings were for future analysis. 

Louver Analysis 
You can use Solar Analysis to create your own custom analysis types, specifying your own date 
and time range, surface selection, and result types, and visualization style. In this example we 
are going to look at how to use Solar analysis for louver design. 

Currently some firms use curtain mullions to represent shade devices but if you are wanting to 
see how the solar analysis is affecting the interior surfaces this process won’t work. Hopefully a 
future release will fix this but for today we will need to use a “Model In-Place” component to 
represent the shade device. 

When using the “user selection” option to select only the surface you want to use for the solar 
analysis a warning will display about the limitation of certain building elements in Revit, see 
Figure 4.5. 
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Figure 4.5: User selection for Solar analysis results 

Below is an example of using the “user selection” option to select the inside floor surface to see 
how the “Model In-Place” shade device is affecting that surface, see Figure 4.6. This is 
comparing two shade devices vs a single shade device. 

 

Figure 4.6: Solar analysis results showing how the shade device is affecting the interior floor 
surface 
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Create Shade Device 
We will go through the process of developing the shade device for a solar analysis. Open “Floor 
Plans – Level 1” on the project browser. Generate a section going through one of the rooms, 
name it “Shade Device”, see Figure 4.7. 

 

Figure 4.7: Create section in Level 1 view and name it 

Model In-Place 
On the ribbon go to the Architecture tab and select the “Component” drop-down, select “Model 
In-Place”. Scroll down and select the “Windows” category and select Ok, name it “Shade 
Device”, and select Ok, see Figure 4.8. 

 

Figure 4.8: Create model in-place 

Reference Plane 
Staying in the “Level 1” view, on the “Create” tab select “Reference Plane” draw it along the 
edge of the window, name it “Shade Device 1”, see Figure 4.9. 
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Figure 4.9: Create reference plane 

Create Shape 
Open the section that you created earlier called “Shade Device”. On the “Create” tab select 
“Extrusion”, select “Set” so the “Reference Plane: Shading Device 1” is current, now draw a 8” x 
1” rectangle for the shade device. Once done, on the ribbon select the “Finish Edit Mode” check 
mark, see Figure 4.10. 

 

Figure 4.11: Create shade device shape using extrusion 

Modify Extrusion 
Open the “Default 3D” view and notice the extrusion is not fitting the window. You can either use 
the “Align” tool to align the edges or you can select the extrusion and use the Properties palette 
to change the length, see Figure 4.12. 



 
 

 

Page 88 

 

Figure 4.12: Modify extrusion to better fit the window width 

Array Extrusion 
This last step is using the “Array” to create multiple copies of the extrusion. The benefit of doing 
this is you can go back to one of the extrusions, change the shape, and all of them will update. 

Go back to the “Shading Device” section view. Select the extrusion and on the ribbon select the 
“Array” tool. On the “Option Bar” change the number to “12” and switch the “Move To:” to the 
option of “Last”, see Figure 4.13. 

 

Figure 4.13: Starting the array tool and defining the settings 

Select a point near the first extrusion edge, now select a point near the top of the window. 
Notice you now have “12” extrusions to represent the shading devices. You can change the 
number any time to update the array. On the ribbon select “Finish Model” and go to the “Default 
3D” view, see figure 4.14. 
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Figure 4.14: Defining the two points and finishing the array tool 

Modify the Shade Device 
If you ever need to redefine the shape or how many extrusions just select the array and, on the 
ribbon, select “Edit in-Place”. Now you can select one of the extrusions to change how many or 
on the ribbon select “Edit Group” to modify the extrusion, see Figure 4.15. 
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Figure 4.15: Modify the array  

Shade Device Solar Analysis 
Open the “Default 3D” view, if you want to run a before and after analysis with the shade 
devices, select the shade devices and on the “View Bar” select the “Temporary Hide/Isolate” 
and select “Hide Element”, see Figure 4.16. 

 

Figure 4.16: Hide shade device for solar analysis 

Select Surface  
On the ribbon select the “Analyze” tab, select the “Solar” tool. Change “Study Type” to 
“Custom”, change “Surfaces” to “User Selection”, and select the “Arrow” icon. A dialog box will 
appear telling you what can used for surfaces, select the “X” in the top right corner. Select the 
interior floor surface and select “Finish” on the “Options Bar”, see Figure 4.17. 
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Figure 4.17: Changing the settings and selecting the inter floor surface 

No Shade Device Results 
For the “Result Settings’ change the “Type” to “Cumulative Insolation” along with the “Style” to 
“Solar Analysis Default”. Now select the “Update” button to see the results, see Figure 4.18. 

 

Figure 4.18: Results with no shade device 
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Shade Device Results 
On the “View Bar” select “Temporary Hide/Isolate” and select “Reset Temporary Hide/Isolate” 
so the shade devices are shown again. If the previous analysis is still shown select the edge of 
the interior floor and use “Delete” to start over, see Figure 4.19. 

 

Figure 4.19: Reset isolate to see shade device and delete the old analysis 

Repeat the same process as before using the same settings and use the “Update” button to see 
the new results with the shade device as part of the analysis, see Figure 4.20. This shows the 
difference between the two designs with and without the shade devices. 

 

Figure 4.20: Comparison between with and without shade devices 
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Managing Results 
Insight Solar Analysis results are visible in 3D views only and are not saved with the Revit file. 
To access results after closing a model, it is suggested to set up 3D views with the preferred 
dates and times preset, so you can quickly generate results for studies. 

Customizing Analysis Visual Styles 
For all analysis types, default analysis display styles are used to visualize results. The steps 
below will allow you to modify these or create your own. In a view that has visible analysis 
results, on the “Properties” palette, select the […] for “Default Analysis Display Style”. 

The styles on the left are all default styles. Select any one of these to see change the 
visualization style in the current view. To create your own style, select “New” and give it a name, 
for solar analysis results, “Colored surface” and “Markers with text” are the styles that should be 
used, see Figure 4.21.  

 

Figure 4.21: Create new display style 

Control the “Settings”, “Color”, and “Legend” in the respective tabs. Adding values associated 
with specific colors will allow you to highlight specific thresholds, see Figure 4.22. 
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Figure 4.22: New display style applied to analysis 

Exporting Results 
Once results have been generated in your 3D view, you can export analysis point location and 
associated data as a CSV. Selecting “Export” will prompt you to name the CSV and specify a 
file destination. The resulting CSV will produce a summary of the simulation and list values of 
individual analysis points and their location in the model, see Figure 4.23. 

 

Figure 4.22: Exported results to an Excel spread sheet 
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How to Get Started 

Best Practices to get started with Insight. Check Energy Analysis is enabled. 

 
 
Check you have the plugin OR download and install.  

 
 
If not installed go to: https://insight.autodesk.com  

 

https://insight.autodesk.com/
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Check if you have entitlements (and cloud credits for Lighting Analysis). Go to: 
https://manage.autodesk.com  

 
 
For Lighting Analysis Only: 

 
 

https://manage.autodesk.com/


 
 

 

Page 97 

 
 

 
 
Create a new 3D view and isolate key architectural elements used. 
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Disable unnecessary elements (optional but faster processing). LINK 

 
 

 
 

 

https://www.linkedin.com/pulse/best-practices-getting-started-autodesk-insight-jarod-schultz/
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